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Team Member Enhancements 

Discussion Feature 

Communication is critical to the success of a project. A new feature in Team Member Web and 

Team Member for iPhone app enables users to communicate with their project manager and 

other team members about a task .  

 All comments are saved with the task and are available for future reference. Comments are 

displayed in the Discussion detail window on the Activities page in P6 and on the Discussion tab in 

Activities Details in P6 Professional.  Also, a new column, Unread Comments, has been added to 

the Activities page in P6 to identify comments waiting review.   

 

 To read comments or add a comment to the discussion thread, click the Discussion icon on the 

selected task row. The icon displays when a task is selected. If the discussion thread contains 

unread comments, the icon displays even if the task is not selected. A numeral over the icon 

indicates the number of unread comments for the task. After the Discussion dialog box is closed, all 

comments are considered read, and the numeral over the icon no longer displays.  

 When a project is locked, comments cannot be posted -- however, the Discussion dialog box can 

be launched to view posted comments.   

 

What’s New in P6 EPPM Release 8.3 
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In the iPhone app, discussions are also saved with the task. 

  

 

 To access this feature: 

In Team Member Web and in the Team Member for iPhone app, select a task and then click the 

Discussion icon .  
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Team Member Work Distribution Filter 

P6 R8.3 provides a work distribution filter that enables a team member who is not the activity owner 

or resource to see a list of tasks that he/she is responsible for updating in the Team Member 

interfaces (Team Member Web, Team Member for iPhone app, E-mail Statusing Service). In P6, 

administrators can create Team Member work distribution filters based on global and EPS activity 

codes, generic resources (not linked to a user), and roles.  

For customers that do not resource-load schedules, this new option allows a filter to be configured 

and assigned to a user to distribute the responsible work. The feature provides flexibility to ensure all 

use cases and project management disciplines can successfully roll out the Team Member 

interfaces to improve decisions and accountability through enterprise-wide visibility and 

collaboration. 

Marking a task with a star, which indicates the task is important, is not available to users assigned 

Team Member work distribution filters. 
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Adding or Deleting Activity Steps 

P6 R8.3 Team Member Web enables users to add, delete, and rename activity steps directly from 

the task list, ensuring the project manager has an accurate picture of the true progress of the task. 

Controls have also been added so the project manager can determine if steps are added and 

deleted by team members. 

Use the Steps panel to view assigned steps and report progress. Select a task in the list and type a 

% complete value. If the step is finished, select the Complete Step check mark. 

Click Add to open the Steps dialog box with a new step already displayed. Edit the name of the 

step as required, and then click Save. Click More in the Steps detail panel to open the Steps dialog 

box with no changes displayed. Highlight a step and then click the red X by its name to delete it or 

click Add in the dialog box to add a step as explained above. Changes are reflected in P6 as soon 

as they are saved. 
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The P6 R8.3 Team Member for iPhone app enables you to add, delete, and rename activity steps 

directly from the task list. 

        

To access this feature: 

In Team Member Web, select a task in the task list. To edit steps, click Add or More in the Steps 

detail panel. In the Team Member for iPhone app, select a task and then tap Steps. 
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Enhanced Filtering of Tasks 

P6 R8.3 Team Member Web provides enhanced filtering of the task list with the addition of a new 

Time frame filter and a text search field. The previous two filter fields -- Projects and that are (now 

renamed Status) -- are retained, with the Status field expanded to include a new option, Due.  

Filters and their available selections are as follows: 

Projects: All projects, or the individual projects (in alphabetical order) to which the user is assigned. 

Multiple projects can be selected at one time. 

Status: Active, Due (scheduled to finish on the current date), Overdue (scheduled to finish before 

the current date), Completed, Starred. 

Time frame: All, Today, Tomorrow, This week, Next week, In next 2 weeks, In next 3 weeks, This 

month, Next month, In next 2 months. When Starred or Overdue is selected in the Status field, the 

Time frame field becomes inactive. When Completed is selected in the Status field, options in the 

Time frame field change to All, Today, Yesterday, This week, Last week, In last 2 weeks, In last 3 

weeks, and This month.  

In addition, a search field enables a user to filter on text displayed on the task list, including Activity 

ID and Name, WBS, Activity Code and Value, and UDF and Value. Filters and search parameter 

interact to return tasks that meet all filter criteria. 
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In Team Member for iPhone app, team members can filter tasks based on a timeframe of Today, 

This Week, or Next Week. 

 

To access this feature: 

The filter fields are located along the top of the TM Web screen. In Team Member for iPhone app, 

the filter options are located at the bottom of the task list. 
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Updating User-Defined Fields and Activity Codes 

In P6 Team Member Web, a new Codes and UDFs detail panel enables team members to view 

and update up to 20 activity codes and UDFs.  

The project manager controls codes and UDFs that are displayed, and also decides whether the 

codes and UDFs can be updated or are read-only.  This functionality serves as another 

communication mechanism between project managers and team members to ensure key data is 

captured.   

The Update History tab on the P6 Activities page displays the codes and UDFs that have been 

updated. 

Select an activity code and its value in the Activity Codes dialog box. 
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Team members can also update codes and UDFs in P6 Team Member for the iPhone app. 

           

E-mail Statusing Service users can view activity codes and UDFs but cannot edit the values. 

To access this feature: 

In Team Member Web, select a task on the task list and then select values in the Codes and UDFs 

detail panel. In Team Member for iPhone app, tap a task and then tap Codes and UDFs. 
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Viewing Notebook Topics 

 P6 R8.3 Team Member Web enables users to view Notebook topics assigned to activities in P6 or P6 

Professional directly from the task list, giving the team member visibility into important task-related 

information such as deliverables and objectives.   

Functionality is read-only; users cannot create or edit a topic. 

To view a Notebook topic and its description, select a task and then click Notebooks. If no 

Notebook topics are assigned to the task, the Notebooks link is not displayed. 

 

 To access this feature: 

On the Team Member Web task list, select a task and then click Notebooks. 
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Viewing Documents 

P6 R8.3 Team Member Web enables users to view documents directly from the task list -- including 

documents stored in Oracle Universal Content Management system, Sharepoint, Work Products 

and Docs, and CMIS-supported documents that are associated to a task and stored on a 

specified file server. This feature allows team members to view important documents such as 

drawings and specifications.   

Select a task and then click Documents. The Documents dialog box displays the names of the 

documents assigned to the task, who created and last modified it, when it was last modified and 

the status.  Click the name of the document link to view the document. 

  

To access this feature: 

On the Team Member Web task list, select a task and then click Documents. 
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Cannot Status Dates in the Future 

In P6 R8.3, Team Member Web, Team Member for iPhone, and the E-mail statusing service do not 

allow users to set an actual start date before the date has occurred, or set an actual finish date 

before the date has been reached. The purpose of this feature is to minimize distortion of project 

schedules. 

When a user clicks the Start button or Completed check mark  on a task row, the Started or 

Finished field in the Details panel retains the scheduled Start or Finish date if that date is earlier than 

the current system date. It is populated with the current system date if the scheduled date is later 

than the current system date. A user can change the date in the Started or Finished field but 

cannot change it to a date later than the current system date.  

 

To access this feature: 

Click the Start button on a task row, or click the Completed check mark for a task in progress. Then, 

click the Calendar icon in the Started or Finished date field in the Details panel. 
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Primary Resource Support on Milestones 

P6 Team Member Web supports primary resources assigned to milestones, ensuring more flexibility 

and usability in all Team Member interfaces, including Team Member for iPhone app and the 

E-mail st  

Previously, milestones were displayed on the TM Web task list only to the activity owners assigned to 

them. TM Web now displays milestones for both activity owners and primary resources.  

Primary resources can mark a milestone complete and status milestone dates. When a primary 

resource is assigned to a milestone, only the Started or Finished fields are active after the milestone 

is marked completed. 

 

To access this feature: 

On the Team Member Web task list, select a milestone activity, designated by the Milestone icon 

. 
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Star Filtering Option in E-mail 

Team members can star a task to quickly and easily filter their list of tasks. They also can use the star 

filter when requesting a task list through e-mail. Previously, team members could request a filtered 

list of tasks by project, time frame, and status, such as Active, Due, Overdue, Completed, and 

Starting. Starred is the new status option. 

 

To access this feature: 

Send an e-mail to the E-mail Statusing Service address, requesting the task list. 
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Sending a Welcome E-mail to Team Members 

In P6 R8.3, team members can receive a Welcome e-mail initiated by their project manager 

containing the e-mail address to the E-mail Statusing Service and instructions for requesting a task 

list and updating the list through e-mail. This feature helps the administrator quickly and efficiently 

ramp up team members. 

The Welcome feature is enabled when Welcome is typed in the subject line of the e-mail. The 

e-mail is sent to team members whose addresses are listed in the body of the e-mail. 

 

To access this feature: 

Log into the e-mail account uniquely associated with the P6 user account and create a new 

e-mail to send to the E-mail Statusing Service address provided by the P6 administrator. In the 

e-mail subject line, type Welcome. For assistance, type Welcome Help in the e-mail subject line to 

receive instructions for using the Welcome e-mail feature.    
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Requesting Updates via E-mail Statusing Service 

Project managers can push e-mails of task lists to team members, eliminating the step of the team 

member requesting their own tasks. The Notify feature enables project managers to send an e-mail 

to the E-mail Statusing Service address, set up by the P6 administrator, with Notify as the keyword 

for sending/pushing the task list e-mail to team members.  

Use the following filter in the Subject line of the e-mail:  

Notify <Task Status> < Optional Time Frame> <Optional Project> 

The Task Status value is required and must be specified. Examples of status values include Active, 

Overdue, Due, Completed, Starting, and Starred. Time Frame and Project values are optional.   

The e-mail is sent to team members whose e-mail addresses are listed in the body of the e-mail. The 

team member receives an e-mail with a list of tasks that match the filter in the Subject line. Team 

members can provide status by replying to the e-mail with their updates.  If no e-mail addresses 

are listed, the e-mail is sent to all resources on the project. 

For assistance, Notify Help is a keyword you can enter in the e-mail subject line to receive 

instructions for using the Notify e-mail feature. 

 

To access this feature: 

Log into the e-mail account uniquely associated with your P6 user account and create a new 

e-mail to send to the E-mail Statusing Service address provided by your P6 administrator. 
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E-Mail View for Progress Reporter Timesheet Users 

Timesheet users can use the E-mail Statusing Service to request a list of their assigned tasks so they 

can see the upcoming tasks on a mobile device.  No updating of the tasks is allowed, but it is a 

good preview of upcoming work. 

 

P6 Status Update Approval Impact 

Project managers can view and respond to feedback as well as approve updates to step names, 

codes, and user-defined fields while reviewing team member status updates in P6, allowing the 

project manager to control changes coming into the schedule.  
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Extended Enterprise 

XML Import/Export Enhancements 

P6 R8.3 provides a number of enhancements to its XML import/export functionality. A user can now 

exchange XML project files with previous version of P6 from R6.2 SP4 onward. Also, all features 

supported by the P6 Professional XER format -- constraining of external relationships during import, 

inclusion of Price/Unit in resource assignments, import of Past Period Actuals -- are supported in XML 

format as well. 

P6 R8.3 also enables a user to import or export multiple projects simultaneously. When exporting 

multiple projects, the projects are combined into a single XML file. Importing multiple projects 

requires the projects to be contained in a single XML file. 

 

To access this feature: 

On the EPS page in the Projects section, click Import/Export, XML Project Import/Export. 
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Granular Control Over Data During XML Import 

A new screen in P6 R8.3's XML project import process enables a user to view data in the incoming 

file and adjust it as necessary before importing it into the database. 

This feature is especially useful to project managers who import third-party schedules that contain 

unwanted data such as resources, codes, and UDFs. In previous versions of P6, they manually 

scanned and then modified the data before importing.  

New import options include the ability to: 

 Move global codes, UDFs, and calendars to project-level data or remove them from the 

import.  

 Map/rename codes, UDFs, resources and calendars to existing values in the database.  

 Specify resource locations for importing resources into a selected hierarchy.  

Import options can be saved as a template for use in subsequent imports. 

 

To access this feature: 

Click the Advanced tab on an XML import template. 
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UN/CEFACT XML Data Export 

P6 8.3 includes support for the UNCEFACT XML schema schedule format. This XML schema is 

designed to exchange schedule and cost data in a software-neutral format.  This is an important 

feature for customers who work with U.S. Department of Defense and other U.S. government 

agencies because as of June 2012 they are required to submit their schedules in the UN/CEFACT 

XML schema format. 

 

To access this feature: 

On the Projects EPS page, click XML Project Import/Export on the Actions menu, and then on the 

Export tab, select UN/CEFACT XML on the Export Type list. 
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Improved Integration with Primavera Unifier 

P6 integration with Primavera Unifier, a project portfolio management application with cost control 

and contract management capabilities, is now improved to simplify setup and enhance usability.  

Changes in P6 R8.3 include: 

 In the new Unifier page in Project Preferences, link a P6 project directly to a Unifier project.  

 Use new options on the General page of Application Settings to specify the Unifier URL, 

Company Name, and Authentication code that identifies the Unifier instance to which you 

are linking. 

 Assign a Cost Breakdown Structure (CBS) code from the linked Unifier project to a P6 

activity. CBS codes are used in Primavera Unifier for cost analysis. 

 A new option on the Actions menu on the EPS or Activities page -- Import/Export, Send to 

Primavera Unifier -- exports one or more open P6 projects to Unifier.  

This feature also is available in P6 Professional when the application is used with P6 EPPM. 

 

To access this feature: 

On the Administer menu, click Application Settings and then select the General page to enter 

settings for the Unifier instance to which you are linking. On the Projects EPS page, click Set Project 

Preferences on the Actions menu and then select the Primavera Unifier page to identify the Unifier 

project, schedule sheet, and data mapping template you are using. On the Activities page, 

display the CBS column to assign Unifier cost codes to individual P6 activities.  
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Adoption and Usability Enhancements 

 Setting a Default Start Page 

P6 R8.3 provides a setting to specify the default start page when a user logs in, simplifying the user 

experience and saving users’ time by taking them to the exact page they need.   

The setting is located on: 

 Content tab of the Details page for a User Interface View 

 View tab in My Preferences 

To set the default start page, first select a P6 section in the Start Page list. Then, in the 

corresponding section, ensure that the start page is the top-most page selected for display. 

 

To access this feature: 

On the Administer menu, click User Interface Views and then select the view whose landing page 

you want to set. Or select My Preferences on the Administer menu and then click the View tab. 
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Renaming Columns 

P6 R8.3 gives users the ability to rename columns on the Activities page. This feature ensures the 

application terminology aligns with the organization and enables users to work with column names 

that are familiar. 

Right-click a column header and select Rename Column to launch the Rename Column dialog 

box. The dialog box displays the column's default name and provides a New name field in which 

you can edit the default name or type in a different name.  

 

To access this feature: 

Right-click a column header on the Activities page. 
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Viewing the Hierarchy for Activity, Project, and Resource Codes 

Codes are heavily used within organizations. In some cases, duplicate codes or code values exist, 

making it difficult to know which is assigned.  To help solve this problem, P6 R8.3 displays the full 

hierarchical chain for assigned project, activity, and resource codes in the Codes detail window. 

Previous releases of P6 displayed only the lowest hierarchical level. Displaying the full chain in the 

detail window can provide useful information without requiring a user to navigate to a codes 

dictionary to view the hierarchy.  

In addition, a new column in the Codes detail window on the Activities page indicates whether an 

assigned activity code is an EPS-, global-, or project-level code. 

   

To access this feature: 

Click the Codes detail window on the EPS or Activities page in the Projects section, or on the 

Resources tab on the Administration page in the Resources section. 
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Sorting on Multiple Columns 

P6 R8.3 enables a user to sort on multiple columns on the Activities, EPS, and Resources Assignments 

pages.  

To sort on multiple columns, click Columns on the View menu or click the Columns icon  in the 

toolbar to launch the Customize Columns dialog box.  

The Customize Columns dialog box now contains two tabs: 

 Columns: Select columns to display in the current view. 

 Sorting: Specify columns to sort by, sorting order (ascending or descending), and column 

sorting priority. Sorting choices can be saved as part of the view. 

As in previous versions of P6, a user can still sort on a single column by clicking the column header. 

When multiple column sorting is in use, column headers in the view display numerals indicating the 

sort order. Click a column header to re-sort the view on the single selected column and delete the 

multi-column options specified on the Sorting tab. 

 

To access this feature: 

Click Columns on the View menu or click the Columns icon  on the Activities, EPS, or Resources 

Assignments page, and then click the Sorting tab in the Customize Columns dialog box. 
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New Relationships Detail Window on Activities Page 

P6 R8.3 offers a new Relationships detail window on the Activities page that enables a user to 

create and manage predecessor and successor relationships within the same window. The 

window provides the same capabilities as the separate Predecessors and Successors detail 

windows. 

 

To access this feature: 

On the Activities page View menu, click Customize Detail Windows and then select the 

Relationships check box. 
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CMIS Connector for Content Repository 

CMIS (Content Management Interoperability Services) is an open standard that defines an 

abstraction layer for different content management systems.  P6 R8.3 supports this standard so 

customers that have existing document management systems such as Documentum, Alfresco, or 

Jack Rabbit, will be able to store and access documents via P6. 

 

To access this feature: 

On the Configurations tab in the Primavera P6 Administrator application, expand the P6 

configuration, Database, the database instance in which you want to configure the CMIS 

connector, and Content Repository. 
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Document Support in Progress Reporter 

In P6 R8.3, users can launch documents uploaded to a content repository directly within Progress 

Reporter, enabling them to view information related to tasks.  

This feature is supported for the following repositories: 

 CMIS 

 SharePoint 

 UCM 10g/11.1.1.1.5 

 UCM 11g (11.1.1.1.6) 

 

To access this feature: 

In the Activities view of Progress Reporter, select a document assigned to an activity, and click 

Details. In the Work Product and Document Details dialog box, click Launch. 
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Improved Printing From the EPS and Activities Pages 

P6 R8.3 allows a user to print from the EPS or Activities page and include only the Project or Activity 

Table with no Gantt chart, offering the flexibility to create a more tabular report. Previous versions 

of P6 printed both the table and the Gantt chart -- even when the Gantt chart was not displayed 

on the screen. The same was true for Print Preview -- the preview included the Gantt chart whether 

or not it was displayed on screen. In P6 R8.3, both Print Preview and Print include only what is 

displayed on the screen. 

 

You can also specify a date range when printing (or previewing) the Gantt chart. On the Activities 

page, choose dates or use rolling options to define a date range, eliminating the need to 

repeatedly open the view to set the time frame. 

Date options include 

 Earliest Project Start 

 Earliest Project BL Start 

 Latest Project Finish 

 Latest Project BL Finish 

 Earliest Data Date 

 Current Date 

 Custom Date 
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Rolling options are plus or minus a specified number of: 

 Days 

 Weeks 

 Months 

 Quarters 

 Years 

 

To access this feature: 

On the EPS or Activities page in the Projects section, click Page Setup on the Actions menu (or click 

the Page Setup icon  from within Print Preview), and then use the Print Range options on the 

Sheet tab. 
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Additional Baseline Fields 

In P6 R8.3, additional baseline fields are available in the Customize Columns dialog box for display 

on the Activities page after a baseline is assigned to a project. 

The new columns/fields are available for both the project baseline (BL) and user's primary baseline 

(BL1): 

 Actual Expense Cost 

 Actual Labor Cost 

 Actual Material Cost 

 Actual Nonlabor Cost 

 Actual Total Cost 

 Actual Start 

 Actual Finish 

 Early Start 

 Early Finish 

 Late Start 

 Late Finish 

 Actual Duration 

 Remaining Duration 

 Free Float 

 Total Float 

 Activity Status 

 Activity % Complete 

 Cost % Complete 

 Duration % Complete 

 % Complete Type 

 Units % Complete 

 Actual Labor Units 

 Actual Nonlabor Units 
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To access this feature: 

On the Activities page in the Projects section, click Columns on the View menu. 
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Selecting Multiple Items in Assign Dialog Boxes 

P6 R8.3 enables a user to assign multiple resources, roles, predecessors or successors at one time on 

the Activities page. Select multiple items in an Assign dialog box using Ctrl-Click (multiple discrete 

selections) or Shift-Click (multiple continuous selection) and then assign them all to an activity 

simultaneously.  

This feature applies to assignments to an activity on the Activities page in the Projects section -- but 

not from the Resource Assignments page or the Resource Planning page. 

 

To access this feature: 

In the Assignments, Predecessors, or Successors detail window on the Activities page in the Projects 

section, click an Assign icon  --     -- to launch the Assign dialog box. 
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Find and Replace Option 

P6 R8.3 enables a user to find and replace text in displayed columns on the EPS, Activities, and 

Resources Assignments pages, making it easier to change items in the project plan. A Find option 

was previously available; the Replace option is new. The new option is available via the Edit menu, 

the Edit toolbar, or the right-click menu. 

 

To access this feature: 

Click Replace on the Edit or right-click menu or click  on the Edit toolbar. 
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Copy Activity Options 

P6 now enables a user to select the data to include when copying and pasting activities on the 

Activities page. This feature can save significant time and effort by reducing the time to manually 

add or remove data when editing or building project schedules. The feature applies to single or 

multiple activities within a single project or across multiple projects. 

On the Activities page, copy/paste one or more activities. The Copy Activity Options dialog box 

displays when you paste the activities. Clear the check boxes for data you do not want to include, 

and then click OK.  

 

To access this feature: 

On the Activities page, the Copy Activity Options dialog box displays as part of the copy/paste 

operation. 
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Discussion Feature 

P6 provides a new Discussion feature that enables team members and project managers to 

communicate about specific activities. All comments are dated and labeled with the contributor's 

name. They are saved with the activity for future reference, allowing contributors to view the entire 

discussion thread before posting a new comment. 

Read or add comments in the Discussion detail window on the P6 Activities page or on the Review 

Status Updates page. A new column, Unread Comments, is available on the Activities page to 

alert project managers to comments awaiting review. The feature can also be accessed through 

Team Member Web, the Team Member for iPhone app, and P6 Professional. 

 

To access this feature: 

Select an activity and then click the Discussion detail window on the Activities page. 
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Improved Filtering 

P6 R8.3 enables a user to filter the EPS, Activities, and Resource Assignments pages by the following 

new fields: 

 Last Modified Date 

 Last Modified By 

 At Completion Labor Units 

 At Completion Nonlabor Units 

Filter the Activities page by the following two fields as well: 

 Feedback from Resource 

 Review Finish Date 

 

To access this feature: 

Click the Add Filter icon  in the Customize Filters dialog box on the Activities or EPS page in the 

Projects section, or the Assignments page in the Resources section. Select fields in the Available 

Columns section. 
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Workflow Enhancements 

BPM Workflow portlets in P6 EPPM have been enhanced for better usability. Some columns have 

been renamed and others have been redesigned to show more comprehensive results.   

Column name changes: 

 Name to Process Name       

 Stage to Activities    

 Status to State     

 Category to Process Name    

 ID to Process ID     

 Priority (in Action Required) to Task Priority 

 Priority (in My Workflows) to Process Priority  

Columns redesigned: 

 Activity column displays Act Name instead of ID  

 Workflow history displays User Login Name instead of ID 

 Owner Column: Display the Owner for task if it is present. Display the OwnerGroup if the BPM 

returns Owner as null 

 Reviewer Column: Display only the Reviewer of the task. Display blank if it is not present.  

Additional columns added: 

 Initiated Date 

 Days Pending 

 Role 

 Description  

Columns Removed: 

 Added By 

 Added Date 
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Progress Reporter Support for User Productivity Kit 

Progress Reporter can be configured to display custom application-support and Help content 

created with Oracle's User Productivity Kit, allowing project teams to reduce the time to 

deployment and ensure end-user adoption. 

When UPK is enabled, the User Productivity Kit link is visible in Progress Reporter's Help menu. 

 

To access this feature: 

In Timesheet Administration Applications Settings, select the option Enable User Productivity Kit and 

enter the URL to launch UPK. 
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Enabling Team Members to Update Activity Codes and UDFs 

Project managers can now enable team members using Team Member Web and the Team 

Member for iPhone app to add and delete activity steps and to update up to 20 activity codes 

and/or user-defined fields (UDFs). Project managers can review code/UDF updates on the Review 

Status Updates page in P6. (E-mail Statusing Service users can view activity codes and UDFs but 

cannot edit the values.) 

  

To access this feature: 

On the EPS page in the Projects section, click Set Project Preferences on the Actions menu, and 

then select Team Member Interfaces. 
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Administration Improvements 

Copying User-Related Views for New Users 

User-level views and multi-user views are copied when an existing user is copied, enabling the 

administrator to furnish new users with preconfigured user-related views. Copied views are 

displayed in the User section of the View list on the EPS, Activities, and Resource Assignments 

pages. 

 

To access this feature: 

Copy an existing user on the Users page and then display views in the Views list on the EPS, 

Activities, or Resource Assignments pages. 
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Job Completion Notification 

P6 R8.3 provides a notification when a requested job service running in the background on the 

Activities page completes, eliminating the need to launch and continually refresh the Service 

Status dialog box.  

Notifications are returned only for ASAP jobs that complete in the background. Notifications are 

not returned for scheduled jobs, for scheduled jobs that run ASAP, or for ASAP jobs that finish 

without being sent to the background. Notifications for these services are returned :  

 Check Schedule 

 Scheduler 

 Leveler 

 Apply Actuals 

 Recalculate Assignment Costs 

 Store Period Performance 

 Summarize Projects 

 Import/Export 

 Send to Fusion 

 

To access this feature: 

On the Projects section EPS or Activities page, initiate a request for one of the job services listed 

above. You can navigate to other sections of P6, and the notification will display regardless of your 

section or page within the application. 
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API and Web Services Enhancements 

API and Web Services have been enhanced with the following: 

 Activity Comment: Fields and a new service have been added to support Team Member 

discussion comments and the ability to assign the comments to activities. 

 Dissolve Activity: A new operation has been added to allow an activity to be dissolved. 

 Timesheet and Resource Hours: New operations have been added for Create, Delete, and 

Update. 

 Team Member: New fields have been added to support new functionality for Team Member 

interfaces including staring activities and unread comment count. 

 Relationship: New enumerations have been added to support cross-project relationships, 

Aref (Adjusted Relationship Early Finish) and Arls (Adjusted Relationship Late Start). 

 Export: New enumerations have been added to support the ability to export EPS specific 

Activity Codes. 

 HistoryInterval: New enumeration has been added to allow daily history. 

 Web Services: Supports Primavera Unifier integration. 

For more details, refer to the P6 EPPM Web Services Programmer's Guide document. 

  

http://docs.oracle.com/cd/E29618_01/English/Integration_Documentation/Web_Services/Programmers_Guide/index.htm
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Improved Selection for Job Services 

More flexibility has been added for the administrator to customize the list of projects job services 

run against.  The new option allows for the selection of a portfolio that consists of a manually 

created list of projects or a filtered list of projects based off a defined filter.   
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Bounce E-mail Address 

P6 R8.3 enables an organization to specify a bounce e-mail address to which any message sent to 

an invalid e-mail address from a user within P6 will be returned. For security reasons, an organization 

should ensure that bounced e-mails are returned to an individual in the IT department -- 

particularly if an application allows mails to be sent from untrusted ‘from’ address. 

 

To access this feature: 

On the Configurations tab in the Primavera P6 Administrator application, expand the P6 

configuration, Services, and Mail Service. 
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Module Access Changes 

P6 R8.3 introduces two changes to the Module Access detail window on the Users page: 

Contributor 

The Team Member module is renamed the Contributor module. This module provides access to 

Progress Reporter and to limited functionality in P6, such as the Dashboards and Projects sections 

(Workspace and Activities pages). For user interface views, only the options on the Activity Editing 

tab apply to contributors. Access to P6 functionality is also determined by a user’s OBS access and 

relationship to the project -- whether the user is assigned as a resource or designated as an activity 

owner. You must clear all other module access options in order to select Contributor module 

access; conversely, you must clear Contributor module access in order to select any other module 

access option. 

Team Member Interfaces 

This option determines user access to P6 Team Member Web. All modules provide access rights to 

P6 Team Member for iPhone app and E-mail Statusing Service; however, only the Team Member 

Interfaces option provides access rights to P6 Team Member Web. Users with Team Member 

Interfaces module access cannot be granted Progress Reporter module access. The fill down 

functionality can be used to quickly assign this access to multiple users. 

  

To access this feature: 

Click User Access on the Administer menu, and then on the Users page, select a user and click the 

Module Access tab. 
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Project Name Instead of DB ID in Content Repositories 

Project documents uploaded to a content repository through P6 R8.3 now reside in corresponding 

project folders labeled with the project name. (In previous versions, in a folder named for the 

project Database ID). This change makes it easier to identify the projects to which documents are 

assigned, especially when multiple projects are open in P6. When the Project Name is edited in P6, 

the corresponding folder name in the content repository is updated accordingly. A migration utility 

packaged with the P6 installer enables you to rename folders from content repositories used with 

earlier versions of P6. 

 

To access this feature: 

Navigate to the Documents page in the Projects section. 
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Password Security 

 Password security policy is enabled by default in P6 R8.3. 

 

To access this feature: 

Click Application Settings on the Administer menu, and then select the General page. 
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Online Help for P6 Professional Settings 

 There are new settings on the General page in Application Settings to enable online help in P6 

Professional (connecting to the EPPM database). A text field allows a user to enter the URL for P6 

Professional online help files. The Always launch Online Help for the F1 shortcut key and 

context-sensitive help check box causes those files to load when users press the F1 key or launch 

context-sensitive help.  

 

To access this feature: 

Click Application Settings on the Administer menu, and then select the General page. 
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Project ID as Filter Option for Creating Portfolios 

P6 R8.3 provides Project ID as a filter option for creating filtered portfolios. The conditional terms 

that are available when Project ID is selected as the filter parameter include: 

 equals 

 is not equal to 

 contains 

 does not contain 

 starts with  

 ends with 

 

To access this feature: 

On the Portfolios menu, click Manage Portfolios, and then on the Manage Portfolios page, click 

Create Project Portfolio. Specify a filtered portfolio and select Project ID on the Parameter list. 
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P6 Professional 

Visualizer 

Visualizer is a new feature that supports graphical reporting by enabling users to create 

customizable Gantt charts and timescaled logic diagrams (TSLDs).  

In addition to the P6 Professional’s standard graphical features, Visualizer enables a user to: 

 Stack columns and use word wrapping in the Gantt chart.  

 Use notebook topics or a list of steps as a bar label or as an field in the activity table. 

 Apply various fonts to individual labels and fields. 

 Color-code and apply different shapes for bars and endpoints. 

 Draw bars on top of each other, for example, to show critical highlighting. 

Visualizer is a desktop application that can be launched either from within P6 Professional or from 

the computer’s start menu.  It has a direct connection to the P6 database and provides live 

access to all  P6 projects.   

When Visualizer is launched, it displays a workspace where you can add, open, print and manage 

layouts. You also can import P6 Professional layouts or Visualizer layouts from other users. 

Choose to create or open a TSLD or Gantt chart. The Gantt chart includes a grid and a bar chart. 

The grid displays activity information in a table format, similar to the Activity Table in P6 Professional. 

On the Chart & Grid tab in Layout Options, display the Gantt chart, the grid, or both. TSLDs enable 

you to display more than one activity per row, which condenses the project plan and the chains of 

activities that drive the project schedule.  

You can run Visualizer layouts in batches for faster periodic reporting. Using a tool like Windows 

Scheduler, schedule the batch runs of reports in advance. 
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When creating layouts, Visualizer obeys settings specified in Admin Preferences in P6 Professional. If 

P6 Professional is connected to a P6 EPPM database, it obeys Application Settings in P6:  

 Weekday on which the calendar week begins 

 Number of work hours for time periods and time abbreviations 

 Online Help settings 
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When creating a layout in Visualizer you can define options, such as filter, group, and sort criteria, 

to customize the Gantt chart or TSLD. The layout below shows activities color-coded by activity 

code values with various shapes for endpoints. 

 

Display baseline bars to compare schedules and stack fields in the activity table to save horizontal 

space. 
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The screen below shows an example of a TSLD with multiple bars per activity and critical activities 

coded in red. 

 

To access this feature: 

In P6 Professional, click Visualizer on the Tools menu or open it directly from the Start menu. 
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Discussion Feature 

P6 Professional provides a new Discussion feature that enables team members and project 

managers to communicate about specific activities. All comments are dated and labeled with the 

contributor's name. They are saved with the activity for future reference, allowing contributors to 

view the entire discussion thread before posting a new comment. 
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Read or add comments in the Discussion tab in the Activities window in P6 Professional. A new 

column, Unread Comments, is available in the Activities window to alert project managers to 

comments awaiting review. The feature can also be accessed through Team Member Web, the 

Team Member for iPhone app, and P6. 

  

 

 

To access this feature: 

In the Activities window, select a task and then click the Discussion tab. 
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XML Import/Export Enhancements 

P6 Professional R8.3 provides a number of enhancements to its XML import/export functionality. A 

user can now exchange XML project files with previous version of P6 Professional from R6.2 SP4 

onward. Also, all features supported by the P6 Professional XER format -- constraining of external 

relationships during import, inclusion of Price/Unit in resource assignments, import of Past Period 

Actuals -- are supported in XML format as well. 

P6 Professional R8.3 also enables a user to import or export multiple projects simultaneously. When 

exporting multiple projects, the projects are combined into a single XML file. Importing multiple 

projects requires the projects to be contained in a single XML file. 

 

To access this feature: 

On the File menu, click Import, or click Export, and then select Primavera P6 - (XML). Click Next to 

select the projects to import or export. 
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Granular Control Over Data During XML Import 

A new screen in P6 Professional R8.3's XML project import process enables a user to view data in the 

incoming file and adjust it as necessary before importing it into the database. 

This feature is especially useful to project managers who import third-party schedules that contain 

data such as resources, calendars, codes, and UDFs. They may want to modify that data to match 

their own data structures. In previous versions of P6, they manually scanned and then modified the 

data before importing .  

New import options include the ability to: 

 Move global codes and calendars to project-level data or remove them from the import.  

 Map codes, UDFs, resources and calendars to existing values in the database or rename 

them.  

 ·Specify resource locations for importing resources into a selected hierarchy.  

Import options can be saved as a template for use in subsequent imports. 

 

To access this feature: 

Click the Advanced tab on an XML import template. 
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Exporting Project Data to UN/CEFACT 

P6 8.3 includes support for the UNCEFACT XML schema schedule format. This XML schema is 

designed to exchange schedule and cost data in a software-neutral format.  This is an important 

feature for customers who work with U.S. Department of Defense and other U.S. government 

agencies because as of June 2012 they are required to submit their schedules in the UN/CEFACT 

XML schema format. 

 

To access this feature: 

On the File menu, select Export. 
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Using Online HTML Help 

The Help menu in P6 Professional 8.3 contains two options: Local Help and Online Help. The Online 

Help feature displays P6 Professional help content in basic HTML format, enabling people with 

disabilities to use the adaptive features of their browsers. 

 

Choose Online Help from the Help menu to launch an URL you specify on the Options tab in the 

new P6 Professional Online Help section in Admin Preferences. The URL defaults to the location of 

the R8.3 files on Oracle Technology Network (OTN). If this field is blank, online help is no longer 

available and local help launches. 

Choose Local Help to have the Help menu behave the same as Contents does in P6 Professional 

R8.2 and earlier. The HTML Help files are installed locally when P6 Professional is installed. Click Local 

Help to launch the local file. By default, the installation location is \\Oracle\Primavera P6\P6 

Professional\Help. 

The Always launch Online Help for the F1 shortcut key and context-sensitive help check box in 

Admin Preferences determines which Help system loads when using the F1 key and launching 

context-sensitive pages. Select the check box to launch online help from the specified URL 

location. By default, the check box is not selected, meaning local help is launched when a user 

uses the F1 key. 

To access this feature: 

Click the Options tab in Admin Preferences. 
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Loading Resource Summary Data on Startup 

The new Resource Summary data setting in the Startup Filters tab of User Preferences enables a 

user to choose whether this type of data will load at startup. If the Resource Summary data check 

box is selected, P6 Professional may take longer to start and some views may take longer to load. 

This setting also affects whether to use resource and role data during project summarization. 

A user also can choose the data filters to run when starting P6 Professional. Startup filters are 

available for Oracle and SQL Server installations. 

 

To access this feature: 

On the Edit Menu, click User Preferences. Click the Startup Filters tab. 
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Improved Integration with Primavera Unifier 

P6 Professional integration with Primavera Unifier, a project portfolio management application with 

cost control and contract management capabilities, is now improved to simplify setup and 

enhance usability.  

Changes include: 

In the new Unifier tab in P6 Professional's Project Details, link a P6 Professional project to a Primavera 

Unifier project and schedule sheet.  

Assign a Cost Breakdown Structure (CBS) code from the linked Unifier project to a P6 

Professional activity in the General tab in Activity Details. CBS codes are used in Primavera Unifier 

for cost analysis. 

In the Unifier tab, select the Primavera Unifier project to link to , specify a schedule sheet, and 

specify the data mapping defined for the schedule sheet. Also choose whether to remove 

activities from Unifier that are not in the P6 Professional schedule and whether to only send 

activities with CBS codes assigned. 

 

To access this feature: 

Open a P6 Professional project and then click the Unifier tab in Project Details. 
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Technical 

Universal Content Management (UCM) 11g 

UCM 11g (11.1.1.1.6) employs a new folder structure, called Frameworks Folder, which offers better 

performance and more efficient storage over the folder structure of UCM 10g/11.1.1.1.5. (UCM 11g 

still supports the folder structure of UCM 10g/11.1.1.1.5 and provides all of the same functionality.) 

Migration Utility for Content Repository 

If using content repository in P6 EPPM, run the Document Migration Utility after upgrading to P6 

EPPM 8.3 to ensure content repository documents are migrated correctly. This utility will ensure 

former Database IDs change to Project IDs. 

To access this feature: 

After the P6 EPPM 8.3 environment has been upgraded, run migrationtool.cmd or migrationtool.sh 

(based on your operating system) located in the P6 home directory. 

Supported Configurations 

All technologies supported by P6 EPPM 8.2 are supported by the P6 EPPM 8.3, with the exception of 

the items listed below.  

Configurations Dropped:  UCM version 11.1.1.5 (Only 11.1.1.6 is supported.) 

Configurations Added: 

 Weblogic version: 12C (12.1.1) 

 OEM version: 12C (this is the only supported version) 

 BPM version: 11.1.1.6 

 Oracle Webcenter Content Core Capabilities: 11.1.1.6 

 WebSphere: 8.5 (this is the only supported version) 

 Localization/Language: Korean 

Software requirement with BPM: Oracle WSM Policy Manager is required when using BPM 11.1.1.6 

with P6 EPPM to ensure that P6 and BPM connects properly. 

Team Member for iPhone language support: Translated into French, German, Spanish, Chinese 

(Simplified), Chinese (Traditional), Japanese, Portuguese (Brazilian), Italian, Russian, Korean. 

  

For a complete list of tested configurations, refer to the Primavera P6 EPPM 8.3 Tested 

Configurations document.  

  

http://docs.oracle.com/cd/E29618_01/tested_configurations.htm
http://docs.oracle.com/cd/E29618_01/tested_configurations.htm
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Support for Multiple Databases 

Progress Reporter now accesses the list of P6 configurations and databases, allowing the 

administrator to choose the appropriate configuration. This feature was first introduced in version 

8.2 Service Pack 1. 

 

To access this feature: 

In the Progress Reporter Administrator in the Database section, select the P6 Configuration and PM 

Database for the environment. 
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Legal Notices 

Oracle Primavera What's New in P6 EPPM Release 8.3 

Copyright © 1999, 2013, Oracle and/or its affiliates. All rights reserved. 

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be 

trademarks of their respective owners. 

This software and related documentation are provided under a license agreement containing 

restrictions on use and disclosure and are protected by intellectual property laws. Except as 

expressly permitted in your license agreement or allowed by law, you may not use, copy, 

reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or 

display any part, in any form, or by any means. Reverse engineering, disassembly, or 

decompilation of this software, unless required by law for interoperability, is prohibited. 
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Government end users are “commercial computer software" pursuant to the applicable Federal 
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subject to license terms and license restrictions applicable to the programs. No other rights are 

granted to the U.S. Government. 
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including applications that may create a risk of personal injury. If you use this software or hardware 

in dangerous applications, then you shall be responsible to take all appropriate failsafe, backup, 
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disclaim any liability for any damages caused by use of this software or hardware in dangerous 
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This software or hardware and documentation may provide access to or information on content, 

products and services from third parties. Oracle Corporation and its affiliates are not responsible for 

and expressly disclaim all warranties of any kind with respect to third-party content, products, and 
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incurred due to your access to or use of third-party content, products, or services. 
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